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File menu commands

The File menu offers the following commands:

New Readies SystemScanTools for a new scan.
Open Scan Opens an existing system scan.
Save Scan Saves an opened system scan using the same file name.
Save Scan 
As

Saves an opened system scan to a specified file name.

Backup Backup (copy) a file to another disk.
Delete Delete a file from your disk.
Print Prints a document.
Print Preview Displays the document on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
Exit Exits SystemScanTools.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Find Finds the name of a file in the displayed list.    Wildcard * is accepted.
Find Next Finds the next occurrence of the name of a file.
Unselect All Unselect all previously made selections in the workspace.



Search menu commands

The Search menu offers the following commands:

Setup This menu selection activates the setup dialog 
box.    This dialog box allows the user to set the 
disk drives to be scanned; the type of file 
extensions to include; and the minimum size of a 
file to be considered.

The setup dialog box parameters work for both 
the duplicate file search and the DLL usage 
search.

Scan For Duplicate Files Searches for duplicate files using the parameters 
specified in the setup dialog box.

Scan For Unused DLLs This selection searches the hard drives specified 
in the setup dialog box for possibly unused 
Dynamic Linked Libraries (DLLs).

Display Current Search Info This selection activates a dialog box with 
information on the results of the last search 
action.

Stop Scan This selection stops a duplicate file scan or an 
unused DLL scan in progress.

Examine An Executable File This menu selection activates the file open dialog 
box allowing the user to locate and get 
information about an executable file.

System Information menu commands

The System Information menu offers the following commands:

Hardware Display information about the computer hardware.
Software Displays information about the computer software.

FPU Accuracy Test Checks the accuracy of your Floating Point Unit.
Scan Active Modules Displays information about the executable modules 

currently active in memory.    Allows the user to 
stop a modules process.



View menu commands

The View menu offers the following commands:

ToolTips Setup Setup for ToolTips
Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Set Font Change the font.
Display Duplicated Files or Unused DLLs Context sensitive display option for 

displaying scan results.
Display All Files Found Display all files found during the 

previous scan.

Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new search workspace in SystemScanTools.

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open Scan command (File menu)

Use this command to open an existing search document in a new window.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box.

List Files of Type
Select the type of file you want to open:
*.sst SystemScanTools version 1.0 search files.

Drives
Select the drive in which SystemScanTools stores the file that you want to open.

Directories
Select the directory in which SystemScanTools stores the file that you want to open.

Network...
If available, choose this button to connect to a network location, assigning it a new drive letter.



Save Scan command (File menu)

Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, SystemScanTools displays the Save As dialog box so you can name your 
document.    If you want to change the name and directory of an existing document before you save it, 
choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save Scan As command (File menu)

Use this command to save and name the active document.    SystemScanTools displays the Save As 
dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    SystemScanTools adds the extension you 
specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
If available, choose this button to connect to a network location, assigning it a new drive letter.



Backup command (File menu)

Use this command to backup (copy with no compression) a file to another disk such as a new, formatted 
floppy.    This command may be used in two ways:

Method 1:

1.    Without selecting (single-clicking) any files displayed in the workspace choose Backup from the 
File menu.

2.    Enter the name and full path of the file to be backed up in the source file edit box.
3.    Enter the full name and path for the destination file in the destination edit box.
4.    Select OK.

Method 2:

1.    After running a duplicate file search or an unused DLL search, select a file from the workspace 
display by single clicking on it.

2.    Select Backup from the File menu.    The name of the file selected file will automatically appear in 
the source file edit box.

3.    Enter the full name and path for the destination file in the destination edit box.
4.    Select OK.

Important Note:    A record of the source location of the backed up file(s) is copied to the root directory of 
the destination disk.    The record is a text file named BAK_FILE.TXT.

Shortcuts

Toolbar:



Delete command (File menu)

This command deletes a file from your disk using the information presented in the search results lists.    
To use this command, run a duplicate file search or an unused DLL search.

1.    Select a file from the results list using a single left mouse button click.

2.    Press the delete key on the keyboard or use the delete selection from the file menu.

3.    SystemScanTools will prompt you twice to be sure you want to delete the file.

Note:    If the selected file is currently in use by Windows, SystemScanTools will warn you that it is in 
use after the first <<are you sure?>> warning message.    Do not delete files currently in use by Windows.

Shortcuts
Key: Delete



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your SystemScanTools session.    You can also use the Close command on 
the application Control menu.    SystemScanTools prompts you to save documents with unsaved 
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

This command is not implemented in SystemScanTools Version 1.0.

Use this command to reverse the last editing action, if possible.      The name of the command changes, 
depending on what the last action was.    The Undo command changes to Can't Undo on the menu if you 
cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Find command (Edit menu)

Use this command to find a specific filename in the displayed file list.    The * as a trailing wildcard is 
allowed.    Use F3 to find further occurrences of the filename string.

Shortcuts
Key: CTRL+F



Find Next command (Edit menu)

Use this command to find the next occurrence of a file as defined in the find command.

Shortcuts
Key: F3

See also Find command.



Unselect All command (Edit menu)

This command is used to unselect a file that was selected using the left mouse button.

Shortcuts
Key: CTRL+A



Setup command (Search menu)

This command displays the SystemScanTools setup tabbed dialog box.    This dialog box is used to set 
parameters for both the duplicate file search and the unused DLL search.

See Section Descriptions:

· General Setup Parameters

· Duplicate File Scan Parameters

· Unused DLL Scan Parameters

Shortcuts

Toolbar:



General Setup Parameters

This section defines the disk drives to be scanned and the minimum file size to consider during the scan.   
These settings are valid for both the duplicate file and unused DLL scan.

Starting/Ending Disk Drive:    The disk drive colon is optional.    Use your mouse to highlight the starting 
or ending drive and type in the new letter.    If you do not have a drive such as the B: drive and you want to
scan A: and C:, SystemScanTools will skip the missing drive.    Valid letters are A through Z.

Ignore files smaller than speeds up the scan process by allowing you to skip small files.

See Also Setup Command



Duplicate File Scan Parameters

Examine all files checkbox.    Uncheck this box if you want to examine files with a specific extension.    
Several suggested file extensions are shown in the file extension edit box.    Highlight the list and type in 
your own specific extensions.    The enter key moves the cursor to the next line.    Default is checked.

NOTE:    The unused DLL search changes the settings in the edit box.

Duplicate File Scan Level  .  

1 - Match File Names Only is the most broad search as it compares only the names of the files for 
equality.    Useful for locating multiple versions of the same file.

2 - Match File Name, Size, Date, Time checks the listed parameters for a more exact match of the file.    
It does not compare the contents of each file with other files.    Default.

Special notes for users of Windows NT 3.5TM:    SystemScanTools will scan both FAT and NTFS 
formatted disks using the 8:3 file naming convention.    Long file names are not currently supported, 
however, the 8:3 abbreviated file names are recognized and utilized.

See Also Setup Command



Unused DLL Scan Parameters

Use DLL Database, when checked, searches for the DLLs listed in the DLL.DAT database.    This 
database is used to eliminate DLLs that are known to be needed by the associated executable.    Default 
is checked.

Exclude 32 bit DLLs from final list, when checked, eliminates 32 bit DLLs from being considered as 
unused.    Default is checked.

Scan INIs for DLL references.    This box, when checked, includes a detailed scan of *.INI files for 
references to DLLs.    Default is checked.

Normal DLL Path Rules Scan,    This button causes the scan for DLL references to follow the default 
protocol for DLL loading.    This means that when an executable references a DLL, Windows first looks for 
the DLL in the current directory, followed by the Windows directory, the Windows\System directory then 
the path.    See also DLL search order

Global DLL Scan (Path rules not used),    This button causes the scan for DLL references to mark as 
used any DLL found on any drive in any directory when a DLL is referenced in an executable file.    This 
identifies the greatest number of DLLs as being used.    Default.

See Also Setup Command



Scan For Duplicate Files command (Search menu)

This command starts the duplicate file scan engine using the parameters defined in the setup dialog box.  
The status of the duplicate file search is shown in the status bar at the lower left of the window.    The 
progress of the currently scanned directory is shown.

When the scan is complete, the workspace displays the duplicate files grouped together with a single 
spaced blank line separating the groups.    If the file is an executable file, you may double-click on it for 
more information.    (Double-clicking on a non-executable file is not harmful, it will only result in a message
stating that the file is not an executable file)    A single click on the file will highlight the line for backup 
and/or delete purposes.

Example:

Duplicated Files Bytes Date Time Path
OLE2CONV.SYM 7,748 11/16/93 16:00 C:\WINDOWS\SYSTEM
OLE2CONV.SYM 7,748 11/16/93 16:00 C:\MSVC\NODEBUG
OLE2CONV.SYM 7,748 11/16/93 16:00 C:\MSVC\DEBUG

If you wish to view all the files that were found, select Window, Display All Files Found.

Shortcuts

Toolbar:



Scan For Unused DLLs command (Search menu)

READ THIS CAREFULLY BEFORE DELETING ANY DLLs!

This command scans for possibly unused DLLs using the parameters defined in the setup dialog box.    
The status of the DLL scan is shown in the status bar at the lower left of the window.    The progress of the
currently scanned directories and files are shown.    See also DLL search order.

When the scan is complete, the workspace displays DLLs that do not have an obvious owner.    See also 
Ownership of a DLL.    These DLLs are candidates for backup and deletion.    They may be extra DLLs 
loaded during the installation of a program or DLLs not removed when a program was uninstalled.    They 
may also be DLLs left over from a previous hardware card that had supporting software.    See Exceptions
to the rules.

Process For Determining If A DLL Should Be Deleted
1. Double-click on the DLL to bring up the File Information Dialog Box.
2. Check the version information, if available, for references to programs you know are installed.    
Do not delete anything that contains a reference (copyright or other) to a vendor of software currently 
installed on your system.    Be very hesistant of deleting anything that iscopyright or produced by 
Microsoft.
3. Rename the DLL to a different extension.
4. Run your most frequently used applications, make sure everything still works--if not, rename the 
DLL back to its original name and dont delete!
5. Rename the DLL back to the original filename.
6. You must then decide if deleting the DLL makes sense.    ALWAYS BACK UP ANYTHING YOU 
INTEND TO DELETE!

To Delete A DLL
Note: DLLs are saved uncompressed on the floppy.    It must be able to fit on the floppy.
1. Back up any DLLs you decide to delete to a new, formatted floppy disk.
2. Highlight the DLL by selecting it and press the Delete key.    If a message comes up indicating the 
DLL is currently in use by Windows, DO NOT delete it.
3. After DLLs are deleted, try running your most frequently used applications to ensure that you 
have not deleted a required DLL.
4. If, when running another application, a message similar to cannot find xxx.dll comes up, note the 
DLL name and load it from your backup floppy using File Manager.    The original location of the DLL is 
saved on the floppy in the file BAK_FILE.TXT.

Shortcuts

Toolbar:



DLL ownership is established several ways:

In a 16 bit executables references to implicitly loaded DLLs are found in the imported names table.    
Explicitly loaded references are found in code and data segments and in the string tables.

References may also be found in .INI files, however, these files may be left over from an uninstalled 
program just like the leftover DLLs.    Using this info is selectable.



DLL Search Order

The DLL search order for both explicit and implicitly imported DLLs is as follows:

1. Check the current directory for referenced DLLs,
2. Check the PenWindows directory,
3. Check the *Windows\System directory,
4. Check the executables directory,
5. Check the directories defined in the path environment variable.

*Or the actual name of the directory on your system.



Exceptions to the rules...

There are exceptions.    SystemScanTools cannot always determine the ownership of some DLLs 
because the owner may be hiding the name of the DLL it needs in another non-executable file.



Display Current Search Info command (Search menu)

This command displays the total quantity of files found and the number of duplicates or unused DLLs 
found.    It also displays the time of the last scan.

Shortcuts

Toolbar:



Examine An Executable File command (Search menu)

Use this command to extract information from an executable file.    This command causes a dialog box to 
activate allowing the user to specify a file to examine.    The File Information dialog box is then activated 
with information about the selected executable file.

Shortcuts

Toolbar:

See also File Information Dialog and Double-Clicking On An Executable File



Stop Scan (Search menu)

This command stops a disk scan in progress.

Shortcuts

Toolbar:



Hardware command (System Information menu)

This command activates a dialog box containing general information about your system hardware.    The 
CPU type, coprocessor presence, and installed memory are displayed above a list box containing 
information about your disk drives.

Notes:    The CPU type displays 80286TM, 80386TM, and i486TM.    PentiumTM processors are currently 
identified as I486TM or Pentium.    The installed memory function returns the amount of installed memory 
for Windows 3.1TM, Windows for Workgroups 3.1TM and 3.11TM.    For Windows NT 3.5TM it returns 
7,808K or less--always.    Under Windows NT 3.51 SystemScanTools displays the correct RAM size.

Shortcuts

Toolbar:



Software command (System Information menu)

This command activates a dialog box containing general information about your system software.    It 
displays information about your systems DOS and Windows version.    It also displays the active operating
system (typically Windows), the mode (standard or enhanced), and whether a swap page file is being 
used.

Shortcuts

Toolbar:



FPU Accuracy Test command    (System Information menu)

This tests the accuracy of your Floating Point Coprocessing Unit by checking the results of 4195835 / 
3145727.

Shortcuts

Toolbar:



Scan Active Modules command (System Information menu)

Use this command to determine the executable modules currently in use by Windows.    The left list box in
the dialog box displays the modules currently loaded by Windows.    The name of the module is shown 
along with the usage count, handle, and full path.

You may double-click on any executable module in the list for full version information about the module.    
The right hand list box shows the executable modules that use the module highlighted in the left hand list 
box.

Advanced users and programmers will find the stop process button very useful.    It allows the user to 
stop the activity of a module and unload it from the Windows process list.    This is extremely useful 
following the crash of a program that loaded DLLs.    When a program terminates unexpectedly, it does 
not properly unload DLLs from memory.    Once you have identified a DLL in this category, you select it 
and press stop process.    This function will also terminate active executables files.

As an experiment, start File Manager and find it in the list as winfile.exe.    Select it, and press stop 
process.

A WARNING about stopping processes:    Stopping a process that is currently in use by Windows may 
result in system instability or immediate crashing---BE CAREFUL!    Do not stop .DRV processes: your 
system will immediately crash.

Shortcuts

Toolbar:



SystemScanTools Version 1.0 currently limits the path to 103 characters including the drive letter and 
colon.    This will be expanded to 256 characters in a subsequent revision.



An executable module is one that executes code.    It can have the extension EXE, DRV, FON, DLL, 386, 
or VBX.



A process is the terminology used in this program to describe what Windows 3.1 calls a task.    To be 
consistent with current Windows 95 terminology, process is used.



ToolTips Setup command (View menu)

Use this command to activate the ToolTips Setup dialog box.    ToolTips are the messages that appear 
near the cursor when the cursor is over a toolbar button.

See also Toolbar for help on using the toolbar.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in SystemScanTools, such as File Open.    A check mark appears next to the menu item when 
the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in SystemScanTools,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    SystemScanTools displays the Open dialog box, in which you can
locate and open the desired file.

Save the active document or template with its current name.    If you have not named the 
document, SystemScanTools displays the Save As dialog box.

Print the active document.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the SystemScanTools window.    To display or hide the status
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Set Font command (View menu)

Use this command to change the font currently used to display scan information.    This command 
activates the standard Windows font dialog box.

Use of a TrueTypeTM font is highly recommended for printing.



Display Duplicate Files or Display Unused DLLs command (View menu)

Use this command to display the results of a scan as determined by the setup dialog box and the last 
request activity.    This switch also works with previously saved searches.

See also Display All Files Found

Shortcuts

Toolbar:



Display All Files Found command (View menu)

Use this command to display all the files found during the previous scan.    This switch also works with 
previously saved searches.

See also Display Duplicate Files or Display Unused DLLs

Shortcuts

Toolbar:



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using SystemScanTools and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice, version number, and serial number of your copy of 
SystemScanTools.



Setup Dialog

This dialog box allows the user to control the scanning actions of SystemScanTools.

See also Setup Command



Hardware Information Dialog

This dialog box provides information on selected aspects of your system hardware.

See also Hardware Command



Software Information Dialog

This dialog box provides information on the versions of MSDOS and Windows.    It also provides 
information on the operating system and the current operational modes.

See also Software Command



Backup File Dialog

This dialog box provides a way for the user to backup (copy) a file to another disk, usually a floppy.    The 
destination disk will also contain a file with a record of the source file locations of the backups made to 
that disk.    The record is called BAK_FILE.TXT.

See also Backup Command



Scan Info Dialog

This dialog box provides information about the most recent scan.

See also Display Current Search Info Command



Active Modules Dialog

This dialog box provides information about the active executable modules currently in use by Windows.    
The user can double-click on a module for internal executable information.    The right hand list shows the 
users of the executable module highlighted in the left hand box.

A method is provided for stopping and closing a process currently running.    Care should be taken with 
this function--Windows may crash if a critical module is stopped.    This function should only be used by 
the most experienced users.

Suggestion:    Never stop a *.DRV process.    *.EXEs are usually safe as are some DLLs and *.FONs.    
Never stop USER.EXE, GDI.EXE, and KRNL386.EXE.

See also Scan Active Modules Command



File Information Dialog

This dialog box provides detailed internal information about executable files.

· The top list box details the type of file.    The results vary with the type of executable file.    This dialog 
will give information about MSDOS, 16 bit Windows (New Executable, NE), 32 bit Windows (Portable 
Executable, PE), OS/2 1.0 and OS/2 2.x and Warp files.

· The lower list box shows version information that is contained in the 16 bit Windows files, if available.

See also Examine An Executable File Command and Double-Clicking On An Executable File



Find Dialog

This dialog box allows the user to find a file name in a scan list.    Using the F3 key will search for the next 
occurrence of the matching filename string.

See also Find Command



ToolTips Setup Dialog

This dialog box allows the user to customize ToolTips.    The checkbox labeled ToolTips Active turns 
ToolTips on and off.

See also ToolTips Setup Command



Context Help command 

Use the Context Help command to obtain help on some portion of SystemScanTools.    When you choose 
the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then 
click somewhere in the SystemScanTools window, such as another Toolbar button.    The Help topic will 
be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

SystemScanTools-A System Toolkit-untitled

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.

The arrow buttons on the scroll bar cause the search results to be moved up or down one line.    Clicking 
on the area above or below the thumb causes the search results to be scrolled up or down a full page.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the SystemScanTools window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should modify a 
document using your application.    

If your application supports multiple document types and you want to have a distinct help topic for each, 
then use the help context i.d. generated by running the MAKEHELP.BAT file produced by AppWizard.    
Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the help 
context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the first 
document type supported by your application.    AppWizard produces an alias in the .HPJ file for your 
application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for that document type. >>



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the AFX_HIDP_xxx 
values from the [ALIAS] section of your .HPJ file, and author a topic for each AFX_HIDP_xxx value.    For 
example, AFX_HIDP_INVALID_FILENAME is the help topic for the Invalid Filename message box. >>



What are SystemScanTools?

SystemScanTools is a program designed to help you free up disk space and clean up your system by:

1. Identifying duplicate files for backup and removal.
2. Identifying potentially unused DLLs for backup and removal.
3. Providing you with internal information about executable files.
4. Providing a way for advanced users to remove programs orphans from memory that are no longer in 

use.
5. Providing you with detailed information about your system.
6. Identifying floating point unit calculation problems.
7. Providing a method for listing the contents of all hard/floppy/CDROM disks and printing or saving the 

list.

· SystemScanTools allows you to save and print the results of duplicate file scans and unused DLL 
scans.    In addition, you can scan for all types of files or only specific kinds.

· One of the most unique features of SystemScanTools is the possibly unused DLL search.    DLLs 
are one of the least understood, mysterious files in the Windows environment.    They are nothing 
more than another kind of executable file that allows its functions to be loaded and executed 
dynamically at run time rather than be permanently included in the original program.    The problem 
with DLLs is you do not know which program uses them.    Often when you remove a program from 
your hard disk you delete everything in the programs main directory.    This may leave you with 
several DLLs in the %windows or %windows\system directory.    SystemScanTools DLL scan utility 
carefully examines executable files and checks for referrences to DLLs.    Possibly unused DLLs are 
presented to the user for floppy backup and delete.

Warning!    Always double-click on each DLL you plan to delete to get the DLLs version and other 
internal information.    The internal information may show that the file is actually used by another program.
Always backup each DLL to a floppy disk before deleting it.

· Have you ever wanted to know what an executable file (those with extensions like EXE, DLL, FON, 
386, DRV, VBX, BIN, COM, SYS, CPL, and OLB etc.) does only to puzzle over a cryptic file name?    
SystemScanTools solves that with a simple double-click on the file in the scan results list or the 
active module list.    If its not in the list, then an executable file examination tool is provided for looking 
at a specific file.    Many Windows files contain a wealth of information about their use.    This 
information is now easily accessible.

· Certain floating point units (FPUs) are known to have specific errors in calculating results.    
SystemScanTools identifies the FPUs that correctly and incorrectly calculate results.

· SystemScanTools also provides general information about the versions of software running on your 
computer.

· The Scan Active Modules utility provides a list of all executable files currently running in your 
system.    You can double-click on them for internal version information and see which other 
processes are using them.    You can stop an executable modules process.

Analyzes 32 Bit Executable Files

· SystemScanTools scans Windows 3.1TM 16 bit executable files and 32 bit PE format Windows 
NTTM, Win32sTM and Windows 95TM files for links to DLLs.    OS/2TM version 2.x and 3.x files are 
recognized, but not scanned.

Network Aware



· SystemScanTools is capable of detecting and scanning network drives.



SystemScanToolsTM From Northwest Performance Software
Copyright 1995 Kirk V. Thomas.    All rights reserved.

The following license agreement covers both the retail and demonstration versions of
SystemScanTools except as noted.

SystemScanTools Software License Agreement

This is a legal agreement between you, the licensee, and Northwest Performance Software.    By 
using this program, you are agreeing to become bound by the terms of this agreement.    If you do 
not agree to the terms of this agreement, promptly return the disk package and the accompanying
items (including written materials and binders and packaging) to the place you obtained them for 
a full refund.

Limitations for SystemScanTools Demonstration Version.    This paragraph applies only to 
SystemScanTools Demonstration: Northwest Performance Software grants to you a nonexclusive 
royalty-free, right to make and use an unlimited number of copies of SystemScanTools Demonstration, 
provided that each copy shall be a true and complete copy, including all copyright and trademark notices. 
The paragraphs entitled Grant of License, Limited Warranty and Customer Remedies do not apply to 
SystemScanTools Demonstration.    All other paragraphs not specifically named are retained and apply 
in full.    NO WARRANTIES. Northwest Performance Software expressly disclaims any warranty for 
SystemScanTools Demonstration.    SystemScanTools Demonstration and any related 
documentation is provided as is without warranty of any kind, either express or implied, including without 
limitation, the implied warranties or merchantability, fitness for a particular purpose, or infringement.    The
entire risk arising out of use or performance of SystemScanTools Demonstration remains with you.    
This concludes the paragraph entitled Limitations for SystemScanTools Demonstration Version.

Grant of License.    Northwest Performance Software grants to you the right to use one copy of the 
enclosed software program, SystemScanTools, (the SOFTWARE) on a single computer.    The 
SOFTWARE is in use on a computer when it is loaded into temporary memory (i.e. RAM) or installed into 
permanent memory (e.g. hard disk, CD-ROM disk, or other storage device) of that computer.    However, 
installation on a network server for the sole purpose of distribution to one or more other computer(s) shall 
not constitute use for which a separate license is required, provided you have a separate license for each 
computer to which the SOFTWARE is distributed.

Copyright.    The SOFTWARE is owned by Northwest Performance Software and is protected by 
United States copyright laws and international treaty provisions.    Therefore, you must treat the 
SOFTWARE like and other copyrighted material (e.g. a book or musical recording) except that you may 
either (a) make one copy of the SOFTWARE solely for backup or archival purposes, or (b) transfer the 
SOFTWARE to a single hard disk provided you keep the original solely for backup or archival purposes.    
You may not copy the written materials accompanying the SOFTWARE.    EXCEPTION: The 
Demonstration Version of the SOFTWARE may be copied within the limitations specified in the paragraph
entitled Limitations for SystemScanTools Demonstration Version.

Other Restrictions.    You may not lease, rent or sub-license the SOFTWARE. You may transfer the 
SOFTWARE and accompanying written materials on a permanent basis provided you retain no copies 
and the recipient agrees to the terms of this Agreement.    You may not reverse engineer, decompile, or 
disassemble the SOFTWARE.

Export Controls.    None of the SOFTWARE or underlying information or technology may be downloaded
or otherwise exported or reexported (i) into (or to a national or resident of) Cuba, Iraq, Libya, Yugoslavia, 
North Korea, Iran, Syria or any other country to which the U.S. has embargoed goods; or (ii) to anyone on
the U.S. Treasury Department's list of Specially Designated Nationals or the U.S.    Commerce 
Department's Table of Deny Orders. By downloading or using the SOFTWARE, you are agreeing to the 



foregoing and you are representing and warranting that you are not located in, under the control of, or a 
national or resident of any such country or on any such list.

U.S. Government Restricted Rights.    The SOFTWARE and documentation are provided with 
RESTRICTED RIGHTS.    Use, duplication, or disclosure by the Government is subject to restrictions as 
set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer Software clause at 
DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software--Restricted 
Rights at 48 CFR 52.227-19, as applicable.    Manufacturer is Northwest Performance Software/PO BOX 
148/Maple Valley, WA 98038.

LIMITED WARRANTY

Limited Warranty.    Northwest Performance Software warrants that the retail version of the 
SOFTWARE is properly recorded on the disk media.    This warranty extends for sixty (60) days from the 
date of purchase.    There is no warranty after the expiration of the warranty period.

Customer Remedies. Northwest Performance Softwares entire liability and your exclusive remedy 
shall be, at Northwest Performance Softwares option, either (a) return of the price paid, or (b) repair or 
replacement of the SOFTWARE that does not meet Northwest Performance Softwares Limited 
Warranty and which is returned to Northwest Performance Software with a copy of your receipt.    This 
Limited Warranty is void if failure of the SOFTWARE has resulted from accident, abuse, or misapplication.
Any replacement SOFTWARE will be warranted for the remainder of the original warranty period or 30 
days, whichever is longer.    In no event shall Northwest Performance Softwares liability exceed the 
purchase price of the SOFTWARE.

NO OTHER WARRANTIES.    To the maximum extent permitted by applicable law, Northwest 
Performance Software disclaims all other warranties, either expressed or implied, including, but 
not limited to, implied warranties of merchantability and fitness for a particular purpose, with 
regard to the SOFTWARE, the accompanying written materials, and any accompanying hardware.  
This limited warranty gives you specific legal rights.    You may have others which vary from state 
to state.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. In no event shall Northwest Performance 
Software or its suppliers be liable for any damages whatsoever (including, without limitation, 
damages for loss of business profits, business interruption, loss of business information, or any 
other pecuniary loss) arising out of the use of or inability to use the SOFTWARE, even if 
Northwest Performance Software has been advised of the possibility of such damages.    Because 
some states/jurisdictions do not allow the exclusion or limitation of liability for consequential or 
incidental damages, the above limitation may not apply to you.

This agreement is governed by the laws of the state of Washington.



Windows 3.1, Windows for Workgroups, Windows NT, Win32s, Windows 95, NTFS, and MS-DOS are 
trademarks of the Microsoft Corporation.

80386, 80486, and Pentium are trademarks of the Intel Corporation.

OS/2 1.0, 2.0, 2.1 and OS/2 Warp are trademarks of the IBM Corporation.



Hardware Requirements

This program requires a 80386TM, 80486TM, or PentiumTM PC or compatible computer running Microsoft 
Windows 3.1TM or Windows for WorkgroupsTM.    This program will function under Windows NT 3.5TM, 
Windows 95TM and OS/2 3.0 WarpTM with certain limitations.    This program also requires a minimum of 4
Megabytes of RAM installed in the computer.



Dynamic Linked Libraries

DLLs are libraries of executable code used for sharing functions between several different programs 
simultaneously at run time.    This is opposed to executable code that is linked to static libraries at compile
time.    By using DLLs, space requirements are reduced since each program does not have to have a its 
own separate statically linked copy of a function.    Several programs can efficiently share functions using 
DLLs.

When information about an executable is extracted through the DLL search or double-clicking on it, 
references are made to implicitly   linked DLLs   and explicitly   linked DLLs  .



Implicit dynamic linking occurs when a DLL is loaded automatically as a result of loading another 
executable module.    The requirement for dependent loading is established at the executables compile 
time and is listed in the imports section of the executable modules header.    Common examples of 
implicitly linked DLLs are USER.EXE, GDI.EXE, MMSYSTEM.DLL, etc.



Explicit dynamic linking occurs when a DLL is loaded at program run time as a result of a call to the 
internal Windows functions LoadLibrary or LoadModule. Explicitly loaded DLLs are not necessarily 
referenced from common specific locations in the executable like the imports list.    They are found in the 
code and data segments and the string tables.    This is why SystemScanTools takes time searching 
each executable for the names of explicitly loaded DLLs.



Functions are modular sections of a program that take an input, modify it, and produce an output.



Portable Executable (PE) format files were developed for use in the 32 bit WindowsTM family:    Windows 
NT 3.1TM and 3.5TM, Win32sTM, and Windows 95TM.    Most PE files cannot be run in 16 bit Windows 
environment without running Win32s.    Exceptions are some files contained in the Microsoft Visual C++TM
16 bit compilers.



16 Bit programs are those programs which use the segmented architecture common to MSDOSTM and 
Windows 3.0TM, 3.1TM, and Windows for Workgroups 3.11TM.



Double-Clicking On An Executable File

Double-clicking on an executable file (*.exe, *.dll, *.386, *.drv, etc.) will activate the File Information Dialog
Box.

See also Examine An Executable File Command and Double-Clicking On An Executable File



Troubleshooting

Printing Problems



Printing Problems

Problem Cause Solution
The printed text 
is real small.

SystemScanTools 
default font is the system
font.    This is a non-
scaleable font and some
printer drivers will 
translate it to a very 
small size.

Under VIEW, SET FONT, change the font to one 
of the TrueTypeTM fonts.    These fonts are scaled
properly to make the printed copy match the 
screen output.



How to contact Northwest Performance Software:

Mailing Address:
PO Box 148
Maple Valley, WA 98038-0148

Voice Phone:
(206) 630-7206
Hours 7pm-9pm    Mon-Thurs,    9am-4pm Fri, Pacific Time
Leave a message, name, phone number, best time to be reached and email address.

Internet:
Mail:    nwps@eskimo.com
WWW:    http://www.eskimo.com/~nwps/index.html



How to register and upgrade your copy of
SystemScanTools

Follow the directions under menu item <help>, <How to register and upgrade...>





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>




